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Foreword
      

      I spend a lot of my time here at Microsoft thinking about complexity—and asking myself lots of questions. My guess is that
         you do the same.
      

      When we design code, we ask ourselves questions such as these: Can I make this code more readable? Can I write this loop with
         fewer lines? Can I factor out behavior into a separate class? Can I architect this system so that it is more cohesive?
      

      When we design user interfaces, we ask similar questions: Are we asking the user to make too many decisions? Did we lay out
         this UI in the clearest possible way? Can we make error states clearer and easier to avoid?
      

      When we design systems, we ask other questions: How many concepts must the user learn? Do those concepts map to things the
         user knows and cares about? Does everything hang together in a clear, sensible, consistent way?
      

      I think about these things a lot. But first I’d like to answer another question that I often get asked: Just how complicated
         is the Entity Framework? The answer is, that it depends on what you want to do with it.
      

      To see how simple the Entity Framework is, let’s spend five minutes making it jump through a simple set of hoops. You’ll need
         Visual Studio 2010 (the Express editions will work) and SQL Server (again, the Express editions will work just fine). In SQL
         Server, create a database called “EntityFrameworkIsSimple.”
      

      

      
         1.  Launch Visual Studio 2010.
         

      

      
         2.  From the View menu, select Server Explorer.
         

      

      
         3.  In Server Explorer, add a new connection to your EntityFrameworkIsSimple database.
         

      

      
         4.  Create a new Console Application project, and call it EntityFrameworkIsSimple.
         

      

      
         5.  Right-click the project and select Add > New Item. In the Add New Item dialog box, select ADO.NET Entity Data Model.
         

      

      
         6.  Click Add.
         

      

      
         7.  In the Entity Data Model Wizard that comes up, select Empty Model and click Finish.
         

      

      
         8.  The entity designer will appear. Right-click in it and select Add > Entity.
         

      

      
         9.  In the Add Entity dialog box, set the entity name to Person. This will automatically make the entity set People. (The set
            is the name of the collection to which you’ll add new instances of the Person class.)
         

      

      
         10.  Click OK.
         

      

      
         11.  A new entity will appear. Right-click on the Properties bar inside of it and select Add > Scalar Property. (Or just click
            on the Insert key.)
         

      

      
         12.  Rename the new property to FirstName.
         

      

      
         13.  Do this again, creating a new property called LastName.
         

      

      
         14.  Add another entity and call it Book.
         

      

      
         15.  To this new entity, add a property called Title.
         

      

      
         16.  Right-click the “Person” text in the Person entity and select Add > Association.
         

      

      
         17.  In the Add Association dialog box, change the Multiplicity on the Person end to * (Many), and change the Navigation Property value at right, from Person to Authors.
         

      

      
         18.  Click OK.
         

      

      
         19.  At this point, your model should look like this:
            

[image: ]

      

      
         20.  Now, right-click on an empty area of the designer and select Generate Database from Model.
         

      

      
         21.  In the Generate Database Wizard that comes up, provide a connection to your database. Because we’ve added a connection
            to the database at the beginning of this walkthrough, it should show up in the drop-down list of available connections.
         

      

      
         22.  Click Next.
         

      

      
         23.  The DDL for a database to hold your model shows up. Click Finish.
         

      

      
         24.  In the T-SQL editor that comes up, right-click and select Execute SQL. Provide your local database information when asked
            to connect.
         

      

      That’s it! We’ve got a model. We’ve got code. We’ve got a database. We’ve even got a connection string in App.Config that
         the designer creates and maintains for you.
      

      Let’s take this model for a test drive. Let’s name the model:

      

      
         1.  In the designer, right-click in an empty area of the canvas and select Properties.
         

      

      
         2.  In the Properties window, find the property called Entity Container Name and change its value to SimpleModel.
         

      

      
         3.  In Program.cs, enter the following code into the body of the Main function:
            

//Create and write our sample data
using (var context = new SimpleModel()) {
  var person1 = new Person() { FirstName = "Stefano", LastName="Mostarda" };
  var person2 = new Person() { FirstName = "Marco", LastName="De Sanctis" };
  var person3 = new Person() { FirstName = "Daniele", LastName="Bochicchio" };
  var book = new Book() { Title = "Microsoft Entity Framework In Action"};
  book.Authors.Add(person1);
  book.Authors.Add(person2);
  book.Authors.Add(person3);
  context.People.AddObject(person1);
  context.People.AddObject(person2);
  context.People.AddObject(person3);
  context.Books.AddObject(book);
  context.SaveChanges();
}
//Query our sample data
using (var context = new SimpleModel()) {
  var book = context.Books.Include("Authors").First();
  Console.Out.WriteLine("The authors '{0}' are:", book.Title);
  foreach(Person author in book.Authors) {
    Console.Out.WriteLine(" - {0} {1}", author.FirstName, author.LastName);
  }
}
Console.Read();

      

      
         4.  Compile and run this code. You should see the following output:
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      As you can see, we’ve created a system that issues queries and updates three different tables. And not a single join statement in sight!
      

      Of course, in the real world, we have many other concerns: How do we bind these types to UI elements? How do we send and update
         them across distributed application tiers? How do we handle concurrency, dynamic querying, and stored procedures? While the
         Entity Framework may be simple to get started with, the real world is not simple, and the Entity Framework has a host of features
         for dealing with real-world situations.
      

      Including an example like this may not be standard for a foreword to a book, but I did so to show how easy getting started
         with Entity Framework is and also to show you where this book comes in. Entity Framework 4 in Action will take you from handling transactions to understanding how to deal with performance problems and using ESQL to writing
         dynamic queries. And it will answer all of your questions along the way—even ones you did not know you had!
      

      I look forward to seeing what you will do with the Entity Framework and to hearing what you want us to work on next. The authors
         are as excited as I am to show you what is in store in the future!
      

      NOAM BEN-AMI
PROGRAM MANAGER
ENTITY FRAMEWORK TEAM, MICROSOFT

      



Preface
      

      Yatta, we did it! We wrote a book about Entity Framework! It’s not our first book, but it’s the first one written in English
         and distributed worldwide. It was a great challenge, but having the opportunity to spread the word about Entity Framework
         made it worth the effort. Entity Framework is a great tool that speeds up the development of data access code and that can
         save you days and days of coding. We know coding is our job, but wouldn’t you prefer to be more productive while writing less
         and better code?
      

      Entity Framework is a great O/RM tool that’s integrated into the .NET Framework, meaning not only is it free, it’s also maintained
         and improved in each .NET Framework release. The result is that it’s a great platform today, and tomorrow it will be an outstanding
         one that will likely rule over all other O/RM platforms.
      

      When we started planning this book, we had a clear idea in mind: we didn’t want to create a reference book; we wanted to create
         a practical one. We wanted you to read about real-world problems and learn real-world solutions. That’s why we developed an
         example and improved on it throughout the book, avoiding common pitfalls and solving problems that you’d face on the job.
      

      This is a book that we felt was missing among those that are available. You won’t find a detailed description of all classes
         and properties here, but you’ll learn the best way to use them and how to combine features to get the most out of Entity Framework.
         We’d love to hear what you think about the book—you can reach us online at the various addresses listed in the “About this
         book” section on page xxiv.
      

      It took a long time to write this book, but now that it’s in your hands we can stop spending endless nights in front of our
         monitors and finally sit down and spend more time with our families.
      

      Now it’s your turn. Enjoy the read, get your hands dirty, and have fun.
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About this Book
      

      Entity Framework is the Microsoft-recommended tool to read and persist data inside a relational database. With this software,
         Microsoft has entered the O/RM market with a reliable product that significantly eases data access development.
      

      This book will take you from the apprentice to the master level in the Entity Framework technology. You can think of this
         book as a guided tour through Entity Framework features and best practices. When you have finished reading Entity Framework 4 in Action, you’ll be able to confidently design, develop, and deliver applications that rely on Entity Framework to persist business
         data.
      

      
Who Should Read this Book?
      

      This book was written for all Entity Framework developers, whether you develop small home applications or the largest enterprise
         systems. Everything from home DVD library applications to e-commerce solutions that interact with many heterogeneous systems
         and store lots of information can benefit from Entity Framework, and this book will show you how.
      

      
Roadmap
      

      This book will walk you through the creation of an application from scratch, and will show you how to keep improving it with
         various Entity Framework features. This Entity Framework tour will cover all of Framework’s features over the course of nineteen
         chapters, grouped in four parts.
      

      In part 1 we introduce the basics of the O/RM pattern and show you the fundamentals of Entity Framework as we create the foundation
         for an application.
      

      Chapter 1 provides a high-level overview of the O/RM pattern and of the Entity Framework components. By the end of this chapter, you’ll
         understand why O/RM tools are so useful and how Entity Framework accomplishes its tasks.
      

      Chapter 2 shows how you can create an application from scratch and how to persist objects in the database. First, you’ll learn two
         ways of designing an application using Entity Framework. Then, after the application is created, you’ll learn how to read,
         manipulate, and persist data. By the end of this chapter, you’ll have a clear understanding of the advantages of adopting
         Entity Framework.
      

      In part 2 of the book, we discuss the main building blocks of Entity Framework in detail: mapping, querying, and persistence.
      

      Chapter 3 covers the basics of querying. Here you’ll learn about the main component that enables Entity Framework to work with objects.
         You’ll also discover how Entity Framework enables you to write queries against your model that will successfully hit the database.
      

      Chapter 4 focuses on querying with LINQ to Entities. In this chapter, you’ll learn how to filter, group, project, and join data using
         the main query language of Entity Framework. By the end of this chapter, you’ll be able to perform any type of query.
      

      Chapter 5 discusses mapping between entities in the model and the database. Here you’ll learn how to accomplish this visually with
         the designer, but you’ll also learn how to manually modify the mapping file. By the end of this chapter, you’ll have a full
         knowledge of the mapping mechanism in Entity Framework.
      

      Chapter 6 tours the entity lifecycle. You’ll learn how Entity Framework treats entities, what state an entity can be in, how to modify
         the state, and how state affects an entity’s persistence. By the end of the chapter, you’ll be able to write code that prepares
         your objects for persistence into the database.
      

      Chapter 7 discusses persisting objects into the database. In chapter 6 you learned how to prepare entities for persistence; here you’ll learn how to actually save them. This subject has many intricacies
         and pitfalls, especially where related entities are involved. This chapter focuses on these potential problems so that you
         can understand and avoid them. By the end of the chapter, you’ll be able to persist any entity in any way you need.
      

      Chapter 8 covers Entity Framework’s concurrency and transaction features. In the first part of the chapter, you’ll be introduced to
         the concept of concurrency and what problems it solves when data is saved to the database. Then you’ll learn how Entity Framework
         lets you easily manage concurrency. Finally, you’ll learn how Entity Framework manages transactions to persist multiple entities,
         and how you can extend a transaction’s lifetime to execute custom commands.
      

      Part 3 of the book will show you how to take advantage of Entity Framework’s most advanced features.
      

      Chapter 9 introduces Entity SQL. Entity SQL is Entity Framework’s other querying language, and it’s still the most powerful (although
         less appealing than LINQ to Entities).
      

      In this chapter, we’ll take the LINQ to Entities examples from chapter 4 and rewrite them in Entity SQL. You can see them side by side and choose the approach that is easier for you. By the end
         of this chapter, you’ll have a full knowledge of all the querying techniques Entity Framework offers.
      

      Chapter 10 covers stored procedures. Here you’ll learn how to have Entity Framework call stored procedures to query and update entities
         instead of having it generate SQL for you. By the end of this chapter, you’ll be able to create your own set of stored procedures
         and have Entity Framework invoke them, so that your DBA is happy.
      

      Chapter 11 discusses views and functions embedded in mapping. You’ll see how to create internal views that can be queried easily, and
         how to create functions that can be reused when querying with both LINQ to Entities and Entity SQL. By the end of this chapter,
         you’ll be able to write queries that are easy to maintain and reusable.
      

      Chapter 12 discusses how to retrieve mapping information. Chapter 5 explains how to map your model classes to database tables and views; in this chapter you’ll learn how to retrieve this mapping
         information. You’ll also see some real-world examples that will demonstrate why this technique is valuable. After finishing
         this chapter, you’ll be able to write powerful generic code that takes data from mapping files.
      

      Chapter 13 covers code generation. Here you’ll discover how Entity Framework is integrated with Visual Studio, and how this integration
         lets you create code and even generate database scripts starting with mapping information. You’ll also discover how to customize
         the Entity Framework designer inside Visual Studio. After you’ve finished this chapter, you’ll be able to fully customize
         the designer, adding behaviors that simplify development.
      

      In part 4 of the book, we’ll show you how to best use Entity Framework with different types of applications: Windows, web, and web
         services applications.
      

      Chapter 14 discusses application design. You’ll learn about the classic three-layer pattern and then go on to the Domain Model pattern.
         Finally, you’ll read about the famous Repository pattern, and learn why it’s a great choice for many applications. By the
         end of this chapter, you’ll be able to create a well-designed and layered application.
      

      Chapter 15 explains how to integrate Entity Framework into ASP.NET applications. In this chapter, you’ll read about ASP.NET controls
         and about best practices for handling objects. This will enable you to create web applications using the correct patterns.
      

      Chapter 16 discusses how to create web service applications. Here you’ll learn about specific features dedicated to the web service
         environment and how and when to use them instead of resorting to other techniques. By the end of this chapter, you’ll have
         a strong understanding of web services and Entity Framework integration.
      

      Chapter 17 explains how to integrate Entity Framework into Windows applications. Here you’ll discover how to let your model classes
         implement a specific interface so that they are integrated with the data-binding capabilities of Windows Form and WPF applications.
         By the end of this chapter, you’ll be able to face everyday problems involving these types of applications.
      

      Chapter 18 covers testing. Here you’ll learn how to test the code that accesses the database and your repositories, and how to create
         batteries of tests to reveal if your modifications have broken something.
      

      Chapter 19 discusses performance. You’ll learn how Entity Framework performance compares to performance in the classic ADO.NET approach.
         You’ll also learn some tricks and tips to improve performance in various situations. By the end of the chapter, you’ll be
         able to boost the performance of your data access code to the edge.
      

      Appendix A introduces LINQ. LINQ to Entities is the most popular querying language for Entity Framework. It’s a dialect of LINQ, so
         to better understand it you should have a good knowledge of LINQ. That’s what this appendix offers.
      

      Appendix B presents some good Entity Framework tips. You won’t learn about new features here, but you’ll learn how to merge existing
         features to produce powerful behaviors. This is your ultimate resource in understanding how much power Entity Framework hands
         you.
      

      
Code Conventions
      

      All source code in listings or set off from the text is in a fixed-width font like this to separate it from ordinary text. The .NET code is provided in both C# and Visual Basic so that you should be comfortable
         with it, whatever your development language. For longer lines of code that won’t fit on the page, a code-continuation character
         ([image: ]) is used to indicate lines that are broken on the page but shouldn’t be broken in the code. Code annotations accompany many
         of the listings, highlighting important concepts. In some cases, numbered bullets link to explanations that follow the listing.
      

      
Source Code Downloads
      

      All the examples in this book can be downloaded from http://www.entityframeworkinaction.com/download.aspx or from the publisher’s website at www.manning.com/EntityFramework4inAction. The code comes in both VB and C# versions.
      

      The code comes with a Visual Studio 2010 solution file so you only need Visual Studio 2010 to run the examples. We did not
         try to open the solution file with Visual Studio Express 2010 (that is the free version), but it’s likely to work.
      

      
Author Online
      

      The purchase of Entity Framework 4 in Action includes free access to a private forum run by Manning Publications where you can make comments about the book, ask technical
         questions, and receive help from the authors and other users. You can access and subscribe to the forum at http://www.manning.com/EntityFramework4inAction. This page provides information on how to get on the forum once you’re registered, what kind of help is available, and the
         rules of conduct in the forum.
      

      Manning’s commitment to our readers is to provide a venue where a meaningful dialogue between individual readers and between
         readers and the authors can take place. It isn’t a commitment to any specific amount of participation on the part of the authors,
         whose contributions to the book’s forum remain voluntary (and unpaid). We suggest you try asking the authors some challenging
         questions, lest their interest stray! The Author Online forum and the archives of previous discussions will be accessible
         from the publisher’s website as long as the book is in print.
      

      In addition to the Author Online forum available on Manning’s website, you may also contact us about this book, or anything
         else, through one of the following avenues:
      

      

      
	Stefano’s blog—http://blogs.5dlabs.it/author/mostarda.aspx


         	Daniele’s blog—http://blogs.5dlabs.it/author/bochicchio.aspx


         	Marco’s blog—http://blogs.aspitalia.com/cradle


      

All comments sent to these blogs are moderated. We post most of the comments, but if you include your email address or phone
         number, we won’t post the comment out of respect for your privacy.
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About the Cover Illustration
      

      The figure on the cover of Entity Framework 4.0 in Action is captioned “Limonaro,” or a vendor of lemons. The illustration is taken from a collection of Italian Fine Arts, Prints, and Photographs that includes hand-colored drawings of Italian regional dress costumes from the nineteenth century. Wearing a white linen
         shirt, blue breeches, and a wide-brimmed straw hat, and carrying a basket of lemons in one hand and a jug of lemonade in the
         other, the itinerant limonaro was a welcome figure in the streets of Italian towns and villages, especially in the hot summer
         weather.
      

      The diversity of the drawings in the collection speaks vividly of the uniqueness and individuality of the world’s towns and
         provinces just 200 years ago. Isolated from each other, people spoke different dialects and languages. In the streets or in
         the countryside, it was easy to identify where they lived and what their trade or station in life was just by what they were
         wearing.
      

      Dress codes have changed since then and the diversity by region, so rich at the time, has faded away. It is now often hard
         to tell the inhabitant of one continent from another. Perhaps, trying to view it optimistically, we have traded a cultural
         and visual diversity for a more varied personal life. Or a more varied and interesting intellectual and technical life.
      

      We at Manning celebrate the inventiveness, the initiative, and the fun of the computer business with book covers based on
         the rich diversity of regional life of two centuries ago brought back to life by the pictures from collections such as this
         one.
      

      


Part 1. Redefining your data-access strategy
      

      Welcome to Entity Framework 4 in Action. Entity Framework is the O/RM tool that Microsoft introduced with .NET Framework 3.5 Service Pack 1 and has now updated to
         version 4.0. This book will enable you to use Entity Framework 4.0 to quickly build data-centric applications in a robust
         and model-driven way. If you’re an Entity Framework novice, you’ll learn how to create an application from scratch and build
         it correctly. If you’re an experienced Entity Framework developer, you’ll find lots of in-depth coverage that will improve
         your knowledge of this powerful tool.
      

      The book is divided into four parts, and part 1 dives right into the fundamentals of Entity Framework. In chapter 1, you’ll discover what an O/RM tool is, and when and why it should be used. You’ll then learn about the modules that make
         up the Entity Framework architecture and how they interact with each other and with you.
      

      Chapter 2 will show you how to build an application from scratch using Entity Framework. Here you’ll be introduced to the example application
         we’ll use throughout the book, and you’ll learn how to create its model and automatically generate code. In the last section,
         you’ll get an overview of how to read data from and persist data to a database.
      

      


Chapter 1. Data access reloaded: Entity Framework
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DataSet and classic ADO.NET approach
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When you design an application, you have to decide how to access and represent data. This decision is likely the most important
         one you’ll make in terms of application performance and ease of development and maintainability. In every project we’ve worked
         on, the persistence mechanism was a relational database. Despite some attempts to introduce object databases, the relational
         database is still, and will be for many years, the main persistence mechanism.
      

      Nowadays, relational databases offer all the features you need to persist and retrieve data. You have tables to maintain data,
         views to logically organize them so that they’re easier to consume, stored procedures to abstract the application from the
         database structure and improve performance, foreign keys to relate records in different tables, security checks to avoid unauthorized
         access to sensitive data, the ability to transparently encrypt and decrypt data, and so on. There’s a lot more under the surface, but these features are
         ones most useful to developers.
      

      When you must store data persistently, relational databases are your best option. On the other hand, when you must temporarily represent data in an application, objects are the best way to go. Features like inheritance, encapsulation, and method overriding
         allow a better coding style that simplifies development compared with the legacy DataSet approach.
      

      Before we delve into the details of Entity Framework, we’ll take the first three sections of this chapter to discuss how moving
         from the DataSet approach to the object-based approach eases development, and how this different way of working leads to the adoption of an
         object/relational mapping (O/RM) tool like Entity Framework.
      

      When you opt for using objects, keep in mind that there are differences between the relational and object-oriented paradigms,
         and the role of Entity Framework is to deal with them. It lets the developer focus on the business problems and ignore, to
         a certain extent, the persistence side. Such object/relational differences are hard to overcome. In section 1.4, you’ll discover that there is a lot of work involved in accommodating them. Then, the last sections of the chapter will
         show how Entity Framework comes to our aid in solving the mismatch between the paradigms and offering a convenient way of
         accessing data.
      

      By the end of this chapter, you’ll have a good understanding of what an O/RM tool is, what it’s used for, and why you should
         always think about using one when creating an application that works with a database.
      

      
1.1. Getting started with data access
      

      Data in tables is stored as a list of rows, and every row is made of columns. This efficient tabular format has driven how
         developers represent data in applications for many years. Classic ASP and VB6 developers use recordsets to retrieve data from
         data-bases—the recordset is a generic container that organizes the data retrieved in the same way it’s physically stored: in rows and columns. When
         .NET made its appearance, developers had a brand new object to maintain in-memory data: the dataset. Although this control is completely different from the recordset we used before the .NET age, it has similar purposes and,
         more important, has data organized in the same manner: in rows and columns.
      

      Although this representation is efficient in some scenarios, it lacks a lot of features like type safety, performance, and
         manageability. We’ll discuss this in more detail when we talk about datasets in the next section.
      

      In the Java world, a structure like the dataset has always existed, but its use is now discouraged except for the simplest applications. In the .NET world, we’re facing
         the beginning of this trend too. You may be wondering, “If I don’t use general-purpose containers, what do I use to represent
         data?” The answer is easy: objects.
      

      Objects are superior to datasets in every situation because they don’t suffer from the limitations that general-purpose structures
         do. They offer type safety, autocompletion in Visual Studio, compile-time checking, better performance, and more. We’ll talk more about objects in section 1.2.
      

      The benefits you gain from using objects come at a cost, resulting from the differences between the object-oriented paradigm
         and the relational model used by databases. There are three notable differences:
      

      

      
	
Relationships— In a tabular structure, you use foreign keys on columns; with classes, you use references to other classes.
         

         	
Equality— In a database, the data always distinguishes one row from another, whereas in the object world you may have two objects of
            the same type with the same data that are still different.
         

         	
Inheritance— The use of inheritance is common in object-oriented languages, but in the database world it isn’t supported.
         

      

This just touches the surface of a problem known as the object/relational mismatch, which will be covered in section 1.4.
      

      In this big picture, O/RM takes care of object persistence. The O/RM tool sits between the application code and the database and takes care of retrieving data and transforming it into
         objects efficiently, tracks objects’ changes, and reflects them to the database. This ensures that you don’t have to write
         almost 80 percent of the data-access code (that’s a rough estimate based on our experience).
      

      
1.2. Developing applications using database-like structures
      

      Over the last decade, we have been developing applications using VB6, Classic ASP, Delphi, and .NET, and all of these technologies
         use external components or objects to access databases and maintain data internally. Both tasks are similar in each language,
         but they’re especially similar for internal data representation: data is organized in structures built on the concept of rows
         and columns. The result is that applications manage data the same way it’s organized in the database.
      

      Why do different vendors offer developers the same programming model? The answer is simple: developers are accustomed to tabular
         representation, and they don’t need to learn anything else to be productive. Furthermore, these generic structures can contain
         any data as long as it can be represented in rows and columns. Potentially, even data coming from XML files, web services,
         or rest calls can be organized this way.
      

      As a result, vendors have developed a subset of objects that can represent any information without us having to write a single
         line of code. These objects are called data containers.
      

      1.2.1. Using datasets and data readers as data containers
      

      At the beginning of our .NET experience, many of us used datasets and data readers. With a few lines of code, we had an object that could be bound to any data-driven control and that, in case of the data
         reader, provided impressive performance. By using a data adapter in combination with a dataset, we had a fully featured framework
         for reading and updating data. We had never been so productive. Visual Studio played its role, too. Its wizards and tight integration with these objects gave us the feeling that everything could be created by dragging
         and dropping and writing a few lines of code.
      

      Let’s look at an example. Suppose you have a database with Order and Order-Detail tables (as shown in figure 1.1), and you have to create a simple web page where all orders are shown.
      

      Figure 1.1. The Order table has a related OrderDetail table that contains its details.
      

      [image: ]

      The first step is creating a connection to the database. Then, you need to create an adapter and finally execute the query,
         pouring data into a data table that you bind to a list control. These steps are shown in the following listing.
      

      Listing 1.1. Displaying a list of orders
      

      C#

      using (SqlConnection conn = new SqlConnection(connString))
{
  using (SqlDataAdapter da = new SqlDataAdapter("Select * from order",
    conn))
  {
    DataTable dt = new DataTable();
    da.Fill(dt);
    ListView1.DataSource = dt;
    ListView1.DataBind();
  }
}

      VB

      Using conn As New SqlConnection(connString)
  Using da As New SqlDataAdapter("Select * from order", conn)
    Dim dt As New DataTable()
    da.Fill(dt)
    ListView1.DataSource = dt
    ListView1.DataBind()
  End Using
End Using

      By doing a bit of refactoring, you get the connection and the adapter in a single method call, so the amount of code is further
         reduced. That’s all you need to do to display the orders.
      

      After playing with the prototype, your customer changes the specifications and wants to see the details under each order in
         the list. The solution becomes more challenging, because you can choose different approaches:
      

      

      
	
Retrieve data from the Order table and then query the details for each order. This approach is by far the easiest to code. By intercepting when an order is bound to the ListView, you can query its details and show them.
         

         	
Retrieve data joining the Order and OrderDetail tables. The result is a Cartesian product of the join between the tables, and it contains as many rows as are in the OrderDetail table.
            This means the resultset can’t be passed to a control as is, but must be processed locally first.
         

         	
Retrieve all orders and all details in two distinct queries. This is by far the best approach, because it performs only two queries against the database. You can bind orders to a control,
            intercept when each order is bound, and filter the in-memory details to show only those related to the current order.
         

      

Whichever path you choose, there is an important point to consider: you’re bound to the database structure. Your code is determined by the database structure and the way you retrieve data; each choice leads to different code, and
         changing tactics would be painful.
      

      Let’s move on. Your customer now needs a page to display data about a single order so it can be printed. The page must contain
         labels for the order data and a ListView for the details. Supposing you retrieve the data in two distinct commands, the code would look like this.
      

      Listing 1.2. Displaying data for a single order
      

      C#

      using (SqlConnection conn = new SqlConnection(connString))
{
  using (SqlCommand cm = new SqlCommand("Select * from order where orderid = 1", conn))
  {
     conn.Open();
     using (SqlDataReader rd = cm.ExecuteReader())
     {
       rd.Read();
       date.Text = ((DateTime)rd["OrderDate"]).ToString();
       shippingAddress.Text = rd["ShippingAddress"].ToString();
       shippingCity.Text = rd["ShippingCity"].ToString();
     }
     using (SqlDataReader rd = cm.ExecuteReader())
     {
       details.DataSource = rd;
       details.DataBind();
     }
  }
}

      VB

      Using conn As New SqlConnection(connString)
  Using cm As New SqlCommand("Select * from order where orderid = 1", conn)
    conn.Open()
    Using rd As SqlDataReader = cm.ExecuteReader()
      rd.Read()
      [date].Text = DirectCast(rd("OrderDate"), DateTime).ToString()
      shippingAddress.Text = rd("ShippingAddress").ToString()
      shippingCity.Text = rd("ShippingCity").ToString()
    End Using
    Using rd As SqlDataReader = cm.ExecuteReader()
      details.DataSource = rd
      details.DataBind()
    End Using
  End Using
End Using

      The way you access data is completely unsafe and generic. On the one hand, you have great flexibility, because you can easily
         write generic code to implement functions that are unaware of the table field names and rely on configuration. On the other
         hand, you lose type safety. You identify a field specifying its name using a string; if the name isn’t correct, you get an exception only at runtime.
      

      You lose control not only on field names, but even on datatypes. Data readers and data tables (which are the items that contain
         data in a dataset) return column values as Object types (the .NET base type), so you need to cast them to the correct type (or invoke the ToString method as well). This is an example of the object/relational mismatch we mentioned before.
      

      Now that you’ve seen the big picture of the generic data-container world, let’s investigate its limitations and look at why
         this approach is gradually being discontinued in enterprise applications.
      

      1.2.2. The strong coupling problem
      

      In the previous example, you were asked to determine the best way to display orders and details in a grid. What you need is
         a list of orders, where every order has a list of details associated with it.
      

      Data readers and data tables don’t allow you to transparently retrieve data without affecting the user interface code. This
         means your application is strongly coupled to the database structure, and any change to that structure requires your code
         to do some heavy lifting. This is likely the most important reason why the use of these objects is discouraged. Even if you
         have the same data in memory, how it’s retrieved affects how it’s internally represented. This is clearly a fetching problem,
         and it’s something that should be handled in the data-access code, and not in the user interface.
      

      In many projects we have worked on, the database serves just one application, so the data is organized so the code can consume
         it easily. This isn’t always the case. Sometimes applications are built on top of an existing database, and nothing can be
         modified because other applications are using the database. In such situations, you’re even more coupled to the database and
         its data organization, which might be extremely different from how you would expect. For instance, orders might be stored
         in one table and shipping addresses in another. The data access code could reduce the impact, but the fetching problem would
         remain.
      

      And what happens when the name of a column changes? This happens frequently when an application is under development. The
         result is that interface code needs to be adapted to reflect this change; your code is very fragile because a search and replace
         is the only way to achieve this goal. You can mitigate the problem by modifying the SQL and adding an alias to maintain the
         old name in the resultset, but this causes more confusion and soon turns into a new problem.
      

      1.2.3. The loose typing problem
      

      To retrieve the value of a column stored in a data reader or a data table, you usually refer to it using a constant string.
         Code that uses a data table typically looks something like this:
      

      C#

      object shippingAddress = orders.Rows[0]["ShippingAddress"];

      VB

      Dim shippingAddress As Object = orders.Rows(0)("ShippingAddress")

      The variable shippingAddress is of type System.Object, so it can contain potentially any type of data. You may know it contains a string value, but to use it like a string, you
         have to explicitly perform a casting or conversion operation:
      

      C#

      string shippingAddress = (string)orders.Rows[0]["ShippingAddress"];
string shippingAddress = orders.Rows[0]["ShippingAddress"].ToString();

      VB

      Dim shippingAddress As String = _
  DirectCast(orders.Rows(0)("ShippingAddress"), String)
Dim shippingAddress As String = _
  orders.Rows(0)("ShippingAddress").ToString()

      Casting and converting cost, both in terms of performance and memory usage, because casting from a value type to a reference
         type and vice versa causes boxing and unboxing to occur. In some cases, conversion can require the use of the IConvertible interface, which causes an internal cast.
      

      Data readers have an advantage over data tables. They offer typed methods to access fields without needing explicit casts.
         Such methods accept an integer parameter that stands for the index of the column in the row. Data readers also have a method
         that returns the index of a column, given its name, but its use tends to clutter the code and is subject to typing errors:
      

      C#

      string address = rd.GetString(rd.GetOrdinal("ShippingAddress"));
string address = rd.GetString(rd.GetOrdinal("ShipingAdres")); //exception

      VB

      Dim address As String = _
  rd.GetString(rd.GetOrdinal("ShippingAddress"))
Dim address As String = _
  rd.GetString(rd.GetOrdinal("ShipingAdres")) 'exception

      The problem resulting from column name changes, discussed in the previous section, involves even the loss of control at compile
         time. It’s not desirable to discover at runtime that a column name has changed or that you have mistyped a column name. Compilers
         can’t help avoid such problems because they have no knowledge of what the name of the column is.
      

      1.2.4. The performance problem
      

      DataSet is likely one of the most complex structures in the .NET class library. It contains one or more DataTable instances, and each of these has a list of DataRow objects made of a set of DataColumn objects. A DataTable can have a primary key consisting of one or more columns and can declare that certain columns have a foreign key relationship
         with columns in another DataTable. Columns support versioning, meaning that if you change the value, both the old and the new value are stored in the column
         to perform concurrency checks. To send updates to the database, you have to use a DbDataAdapter class (or, more precisely, one of its derived classes), which is yet another object.
      

      Although these features are often completely useless and are ignored by developers, DataSet internally creates an empty collection of these objects. This might be a negligible waste of resources for a standalone application,
         but in a multiuser environment with thousands of requests, like a web application, this becomes unacceptable. It’s useless
         to optimize database performance, tweaking indexes, modifying SQL, adding hints, and so on, if you waste resources creating
         structures you don’t need.
      

      In contrast, DataReader is built for different scenarios. A DataTable downloads all data read from the database into memory, but often you don’t need all the data in memory and could instead
         fetch it record by record from the database. Another situation is in data updates; you often need to read data but don’t need
         to update it. In such cases, some features, like row versioning, are useless. DataReader is the best choice in such situations, because it retrieves data in a read-only (faster) way. Although it boosts performance,
         DataReader can still suffer from the casting and conversion problems of DataSet, but this loss of time is less than the gain you get from its use.
      

      All of these problems may seem overwhelming, but many applications out there benefit from the use of database-like structures.
         Even more will be developed in the future using these objects without problems. Nonetheless, in enterprise-class projects,
         where the code base is large and you need more control and flexibility, you can leverage the power of object-oriented programming
         and use classes to organize your data.
      

      
1.3. Using classes to organize data
      

      We’re living in the object-oriented era. Procedural languages still exist, but they’re restricted to particular environments.
         For instance, COBOL is still required for applications that run on mainframe architectures.
      

      Using classes is a natural choice for most applications today. Classes are the foundation of object-oriented programming.
         They easily represent data, perform actions, publish events, and so on. From a data organization point of view, classes express data through methods and properties (which,
         in the end, are special methods).
      

      By using classes, you can choose your internal representation of data without worrying about how it’s persisted—you need to
         know nothing about the storage mechanism. It could be a database, a web service, an XML file, or something else. Representing
         data without having any knowledge of the storage mechanism is referred to as persistence ignorance, and the classes used in this scenario are called POCOs (plain old CLR objects).
      

      The use of classes offers several benefits that are particularly important in enterprise applications:

      

      
	
Strong typing— You no longer need to cast or convert every column in a row to get its value in the correct type (or, at least, you don’t
            have to do it in the interface code).
         

         	
Compile-time checking— Classes expose properties to access data; they don’t use a generic method or indexer. If you incorrectly enter the name of
            a property, you immediately get a compilation error. You no longer need to run the application to find typos.
         

         	
Ease of development— Editors like Visual Studio offer IntelliSense to speed up development. IntelliSense offers the developer hints about the properties,
            events, and methods exposed by a class. But if you use DataSet, editors can’t help you in any way, because columns are retrieved using strings, which aren’t subject to IntelliSense.
         

         	
Storage-agnostic interface— You don’t have to shape classes to accommodate the structure of the database, which gives you maximum flexibility. Classes
            have their own structure, and although it’s often similar to that of the table they’re related to, it doesn’t need to be.
            You no longer have to worry about database organization and data retrieval, because you code against classes. Data-retrieval
            details are delegated to a specific part of the application, and the interface code always remains the same.
         

      

To get a look at these concepts in practice, let’s refactor the example from the previous section.

      1.3.1. Using classes to represent data
      

      Let’s start from scratch again. The customer wants to display orders in a grid. The first step is to create an Order class to contain order data, as shown in figure 1.2.
      

      Figure 1.2. The Order class contains data from the Order table.
      

      [image: ]

      The Order class has the same structure as the related database table. The only obvious difference here is that you have .NET types
         (String, Int32, DateTime) instead of database types (int, varchar, date).
      

      The second step is to create a class with a method that reads data from the database and transforms it into objects, as in
         the following listing. The container class is often in a separate assembly, known as data layer.
      

      Listing 1.3. Creating a list of orders
      

      C#

      public List<Order> GetOrders()
{
  using (SqlConnection conn = new SqlConnection(connString))
  {
    using (SqlCommand comm = new SqlCommand("select * from orders", conn))
    {
      conn.Open();
      using(SqlDataReader r = comm.ExecuteReader())
      {
        List<Order> orders = new List<Order>();
        while (rd.Read())
        {
          orders.Add(
            new Order
            {
              CustomerCode = (string)rd["CustomerCode"],
              OrderDate = (DateTime)rd["OrderDate"],
              OrderCode = (string)rd["OrderCode"],
              ShippingAddress = (string)rd["ShippingAddress"],
              ShippingCity = (string)rd["ShippingCity"],
              ShippingZipCode = (string)rd["ShippingZipCode"],
              ShippingCountry = (string)rd["ShippingCountry"]
            }
          );
        }
        return orders;
      }
     }
  }
}
...
ListView1.DataSource = new OrderManager().GetOrders();
ListView1.DataBind();

      VB

      Public Function GetOrders() As List(Of Order)
  Using conn As New SqlConnection(connString)
    Using comm As New SqlCommand("select * from orders", conn)
      conn.Open()
      Using r As SqlDataReader = comm.ExecuteReader()
        Dim orders As New List(Of Order)()
        While rd.Read()
          orders.Add(New Order() With {
            .CustomerCode = DirectCast(rd("CustomerCode"), String),
            .OrderDate = DirectCast(rd("OrderDate"), DateTime),
            .OrderCode = DirectCast(rd("OrderCode"), String),
            .ShippingAddress = DirectCast(rd("ShippingAddress"), String),
            .ShippingCity = DirectCast(rd("ShippingCity"), String),
            .ShippingZipCode = DirectCast(rd("ShippingZipCode"), String),
            .ShippingCountry = DirectCast(rd("ShippingCountry"), String)
          })
        End While
        Return orders
      End Using
    End Using
  End Using
End Function
...
ListView1.DataSource = New OrderManager().GetOrders()
ListView1.DataBind()

      “What a huge amount of code!” That’s often people’s first reaction to the code in listing 1.3. And they’re right; that’s a lot of code, particularly if you compare it with listing 1.1, which uses a dataset. If your application has to show simple data like this, the data-set approach is more desirable. But
         when things get complex, classes help a lot more.
      

      Let’s take a look at the next required feature: displaying a single order in a form. After the order is retrieved, displaying
         its properties using classes is far more straightforward:
      

      C#

      shippingAddress.Text = order.ShippingAddress;
shippingCity.Text = order.ShippingCity;

      VB

      shippingAddress.Text = order.ShippingAddress
shippingCity.Text = order.ShippingCity

      The final step is showing the orders and related details in a grid. Doing this requires in-depth knowledge because it introduces
         the concept of models. You can’t represent orders and details in a single class—you have to use two separate classes the same way you do with tables.
         In the next section, we’ll discuss this technique.
      

      1.3.2. From a single class to the object model
      

      You have now seen how to develop a single standalone class and how to instantiate it using data from a database, but the real
         power comes when you create more classes and begin to link them to each other (for instance, when you create an OrderDetail class that contains data from the OrderDetail table).
      

      In a database, the relationship between an order and its detail lines is described using a foreign key constraint between
         the OrderId column in the Order table and the OrderId column in the OrderDetail table. From a database design point of view,
         this is the correct approach.
      

      In the object-oriented world, you have to follow another path. There’s no point in creating an OrderDetail class and giving it an OrderId property. The best solution is to take advantage of a peculiar feature of classes: they can have properties whose type is a user-defined class. This means the Order class can hold a reference to a list of OrderDetail objects, and the OrderDetail class can have a reference to Order.
      

      When you create these relationships, you’re beginning to create an object model. An object model is a set of classes related to each other that describe the data consumed by an application.
      

      The real power of the object model emerges when you need to show orders and their related details in a single grid. In section 1.2.1, there was a fetching problem with a spectrum of solutions. Every one was different, but what’s worse is that every one required
         a different coding style on the interface.
      

      Using classes, your interface code is completely isolated from fetching problems because it no longer cares about the database.
         A specific part of the application will fetch data and return objects. This is where the storage-agnostic interface feature
         of using classes comes into play.
      

       




	
            




         The Object Model and Domain Model patterns
         The Object Model and Domain Model patterns are often considered to refer to the same thing. They may initially look exactly the same, because both carry data
            extracted from storage. But after digging a bit, you’ll find that they have differences: the object model contains only the
            data, whereas the domain model contains data and exposes behavior.
         

         The Order class that we’ve been looking at is a perfect expression of an object model. It has properties that hold data and nothing
            more. You could add a computed property that reports the full address by combining the values of other properties, but this
            would be a helper method. It wouldn’t add any behavior to the class.
         

         If you want to move on from an object model to a domain model, you have to add behavior to the class. To better understand
            the concept of behavior, suppose you need to know if an order exceeds the allowed total amount. With an object model, you
            have to build a method on another class. In this method, you call the database to retrieve the maximum amount allowed, and
            then compare it with the amount of the order. If you opt for a domain model, on the other hand, you can add an IsCorrect method to the Order class and perform the check there. This way you’re adding behavior and expressiveness to the Order class.
         

         Creating and maintaining a domain model isn’t at all easy. It forces the software architect to make choices about the design
            of the application. In particular, classes must be responsible for their own validation and must always be in a valid state.
            (For instance, an order must always have a related customer.) These checks may contribute to code bloating in the classes;
            so, to avoid confusion, you may have to create other classes that are responsible for validation, and keep those classes in
            the domain model.
         

         The details of the Object Model and Domain Model patterns are beyond the scope of this book and won’t be covered, but plenty
            of books focus on this subject and all its implications. We recommend Domain Driven Design by Eric Evans (Addison-Wesley Professional, 2004). We’ll discuss the Domain Model pattern and Entity Framework in chapter 14.
         

      

      


	
            



 

The example we’ve looked at so far is oversimplified. You’ll have noticed that the Order class has a CustomerId property and the OrderDetail class has a ProductId property. In a complete design, you’d have Customer and Product classes too. Likely, a customer has a list of applicable discounts based on some condition, and a product belongs to one
         or more categories. Creating a strong object model requires a high degree of knowledge, discipline, and a good amount of practice.
      

      At first sight, it may seem that a one-to-one mapping between classes and database tables is enough. Going deeper, though,
         the object-oriented paradigm has much more expressiveness and a different set of features compared with the database structure.
         Inheritance, many-to-many-relationships, and logical groups of data are all features that influence how you design a model.
         More importantly, such features create a mismatch between the relational representation and the model; in literature, this
         problem is known as the object/relational mismatch, and it’s discussed in the next section.
      

      
1.4. Delving deep into object/relational differences
      

      Understanding the differences between the object-oriented and relational worlds is important, because they affect the way
         you design an object or domain model and the database.
      

      The mismatch can be broken down into different parts relating to datatypes, associations, granularity, inheritance, and identity,
         and in the following sections we’ll look at them in turn. To better illustrate this mismatch, we’ll make use of the example
         introduced in previous sections.
      

      1.4.1. The datatype mismatch
      

      The datatype mismatch refers to the different data representations and constraints that are used in the object and relational worlds. When you
         add a column to a table in a database, you have to decide what datatype to assign to it. Any modern database supports char, varchar, int, decimal, date, and so on. When it comes to classes, the situation is different. Database int and bigint types fit naturally into .NET Int32 and Int64 types, but other database types don’t have an exact match in .NET.
      

      In the database, when you know that the value of a column has a maximum length, you set this constraint into the column to
         enforce the business rule. This is particularly desirable when the database serves several applications, and yours isn’t the
         only one that updates data. In .NET, varchar doesn’t exist. The nearest type to varchar is String, but it doesn’t support any declarative limitations on its length (it can contain 2 GB of data). If you want to check that
         the value of the String isn’t longer than expected, you have to implement this check in the setter of the property, or call a check method before
         sending the data back to the database.
      

      Another example of this mismatch involves binary data. Every database accepts binary data, but the column that contains the
         data doesn’t know anything about what the data represents. It might be a text or PDF file, an image, and so on. In .NET, you
         could represent such a column using an Object, but it would be nonsense, because you know perfectly well what kind of data you have stored in the binary column. If the value is a file, you can use a Stream property, whereas the Image type is your best choice for images.
      

      One last example of the datatype difference emerges when you use dates. Depending on the database vendor and version, you
         have lots of datatypes you can use to store a date. For instance, until version 2005 of SQL Server, you had DateTime and Small-DateTime. SQL Server 2008 has introduced two more datatypes: Date and Time. As you can imagine, the first contains only a date and the second only a time. In .NET, you have only a DateTime class that represents both date and time. Handling this mismatch isn’t difficult, but it requires a bit of discipline when
         instantiating the object from database data and vice versa.
      

      As you can see, the datatype mismatch is trivial and doesn’t cause developers to lose sleep at night. But it does exist, and
         it’s something you must take care of.
      

      The second difference, which already emerged in section 1.2, is the association between classes. Databases use foreign keys to represent relationships, whereas object-oriented applications
         use references to other objects. In the next section, we’ll go deeper into this subject.
      

      1.4.2. The association mismatch
      

      When talking about associations, the biggest mismatch between the relational and object worlds is how relationships are maintained.
         Database tables are related using a mechanism that is different from the one used by classes. Let’s examine how the cardinality
         of relationships is handled in both worlds.
      

      
One-to-One Relationships
      

      The Order table contains all the data about orders. But suppose the application needs to be improved, and an additional column
         has to be added to the Order table. This may initially seem like a minor improvement, because adding a column isn’t too dangerous.
         But it’s more serious than that. There may be lots of applications that rely on that table, and you don’t want to risk introducing
         bugs. The alternative is to create a new table that has OrderId as the primary key and contains the new columns.
      

      On the database side, that’s a reasonable tradeoff, but repeating such a design in the object model would be nonsense. The
         best way to go is to add properties to the Order class, as shown in figure 1.3.
      

      Figure 1.3. The Order2 table contains columns for the new data and is related to the Order table. In the object model, there’s no new
         class—just a new property on the Order
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